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IMAGENEX MODEL 872  
“YELLOWFIN”  

SIDESCAN SONAR  
 
 
APPLICATIONS:    FEATURES: 
 

• Underwater Archaeology        •  Triple frequency 
• Sunken Timber Recovery         •  High resolution 1000 data points per side 
• Search & Recovery         •  300 m depth rating 
• Surveying          •  Up to 400 m (1300’) total coverage 
• Law Enforcement Work         •  23 m (75’) tow cable included 
• Scientific Research         •  LAN compatible 
• Environmental Survey         •  Built-in track plotter 

      •  Built-in internal GPS receiver 
      •  Record to .XTF in real-time              
  

The Imagenex Model 872 “YellowFin” is a full-
featured dual channel, high resolution, sidescan sonar.  
The YellowFin is an affordable, very user friendly system 
that incorporates a high speed Ethernet connection to 
your Windows™ based laptop or desktop PC. Integrated 
power and a built-in differential-ready GPS receiver 
complete this fantastic system.  Zoom windows are 
available for target investigation without interrupting real-
time data acquisition.  Data is displayed in real-time, with 
or without speed correction, in 9 user selectable colour 
tables. 
 
UNDERWATER HARDWARE 
SPECIFICATIONS: 
FREQUENCY 260 kHz / 330 kHz / 770 kHz nominal 
TRANSDUCER One transducer per side, tilted down 20° 
TRANSDUCER BEAM WIDTH 260 kHz:  2.2° x 75°  

330 kHz:  1.8° x 60° 
770 kHz:  0.7° x 30°  

RANGE RESOLUTION Range scale ÷ 1000 
MAX. OPERATING DEPTH 300 m (~1000’) 
MAX. CABLE LENGTH 600 m (~2000’) 
INTERFACE Analog telemetry 
CONNECTOR Wet mateable  (Impulse MCBH-4-MP) 
POWER SUPPLY 40 – 55 VDC at less than 3 Watts,  

supplied from Surface Interface Box 
DIMENSIONS  114 mm (4.5”) diameter x 833 mm (32.8”) length 
WEIGHT: In Air 
  
                          In Water 

5.4 kg (12 lbs)     
                         not including ballast 
1.8 kg ( 4 lbs)      

BALLAST Standard diver belt weights (readily available at dive shops) 
MATERIALS Polyurethane & 6061-T6 Aluminum 
FINISH Hard anodized 

Specifications subject to    Copyright © 2004 - 2006 
change without notice  www.imagenex.com Imagenex Technology Corp. 



SURFACE INTERFACE BOX  
HARDWARE SPECIFICATIONS: 
INTERFACE TO PC 10 Mbps Ethernet  
INTERFACE TO SONAR HEAD FSK analog telemetry 
CABLE CONNECTOR 5-pin MS (female) 
SONAR HEAD 
POWER SUPPLY OUTPUT 48 VDC 

DIFFERENTIAL CAPABLE GPS Built-in 
DIMENSIONS  31 cm (12.2”) length x 26 cm (10.2”) width x  

8.7 cm (3.4”) height  
WEIGHT 0.9 kg ( 2 lbs) 
MATERIALS Aluminum 
FINISH Powder Coated 
POWER REQUIREMENT 110 / 220 VAC 50 / 60 Hz, 0.1 Amp 
 
 
SOFTWARE 
SPECIFICATIONS: 

YellowFin.exe 

WINDOWS™ OPERATING SYSTEM Windows™ 98, Me, NT, 2000, XP 
ZOOM MODES 1x, 2x, 3x, 4x, and 5x dynamically moveable 
RANGE SCALES 10 m, 20 m, 30 m, 40 m, 50 m, 60 m, 80 m, 100 m,  

125 m, 150 m, and 200 m 
FILE FORMAT (filename).872, (filename.XTF) 
GPS INPUT (4800, N, 8, 1) 
        NMEA 0183 FORMATS: 

 
GLL and VTG; GGA and VTG; RMC 

RECOMMENDED 
MINIMUM COMPUTER 
REQUIREMENTS: 

800 MHz Pentium 3 
256 MB RAM 
2 GB Hard Disk 
1024 x 768 x 256 colour graphics 

 
 
ORDERING  
INFORMATION: 
300 m unit w / 23 m tow cable Standard 872-000-150 
Surface Interface Box Standard 872-000-001 
60 m (200’) Sidescan tow cable Option                     -021 
 
 

Product and company names listed are trademarks or trade names of their respective companies.
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Setting up your YellowFin® for use 
 
Unpack your YellowFin and check for the following parts: 
 
 

1. Nose 
2. Aluminum Tube 
3. Tail 
4. Ballast Plate 
5. Surface Processor 
6. Kevlar strength tow cable 
7. User’s Guide 
8. Sonar CD 
9. GPS Antenna 
10. Power cord 
11. Serial cable 
12. Ethernet cable 
13. U/W connector 
14. MS connector 
15. Plastic retaining rods 
16. Cable ties 
17. Shackle 

 
Connecting the cable to the YellowFin 
 

1. Apply a small amount of silicon grease to the rubber part of the male 
pins on the electronics bulkhead. 

2. Check the orientation of the two connector halves and carefully but 
firmly push them together.  Slide the locking sleeve into position and 
screw into place (Fig. 1). 

3. Install the tail back into the aluminum tube, taking care to fit the cable 
into the slot provided.  Thread the plastic retaining rod into the groove 
completely (Fig. 2). 

4. Attach the cable thimble to the aluminum tube using the shackle 
provided (Fig. 3). 

 
 

 
 

Fig. 1 Fig. 2 Fig. 3  



 
Installing Ballast 
 

1. Extract the ballast plate from inside the aluminum tube (Fig. 4).  Make 
a note of the orientation. 

2. The YellowFin is designed to use conventional 3 lb lead diving weights 
as ballast* (Fig. 5). 

3. Add at least 15 – 20 lbs of ballast as far forward and as low as 
possible, securing the weights with cable ties.  Adding more weight will 
allow the YellowFin to be towed at a greater depth. 

4. Slide the ballast plate back into the aluminum tube, install the nose 
cone, and thread the plastic retaining rod into the groove completely 
(Fig. 6). 

 
*Ballast weights are not included 
 

 
Fig. 4 Fig. 5 Fig. 6  

 
 
Trimming the YellowFin by adjusting the tow shackle position 
 
Immerse the YellowFin in still water, and adjust the shackle position so that the 
YellowFin lies parallel to the water surface (ensure that no air is trapped in the 
aluminum tube, as this will give a false indication).  If the YellowFin wanders 
while being towed, adjust the shackle position so that the towfish is slightly nose 
heavy. 



 
 
 
 
 

 
 
 
 

WARNING:  AVOID IMPACT TO  
SENSITIVE TRANSDUCER AREA 
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What’s New in 1.08

Below is a list of changes since 1.07.

• Added GPS info at the cursor line. Includes lat/long/speed/heading to the
mark.( See Show GPS Marks )

• Added option to show or hide the “Range Display” at the upper left corner.
(See Show Range )

• Added sound notification for any changes during file playback (range,
frequency change, and end of file). ( See Settings Change Alarm)

• Enabled Drag and Drop of data file to YellowFin.exe, and Double-Click data
file to open.

• Added a command to convert GPS time to local time. ( See Convert UTC to
Local Time)

• Added a time sync option that sets the PC clock to be the same as the GPS
time. (See Synchronize with GPS Time)

• "z" accelerator zooms the screen about the mouse cursor position. ( See Zoom
In )

• Moved "sonar settings" to main menu.

• .XTF file playback displays lat/long in dd.mm.mmmm format.

• When using the "Reverse Grey" color table, text changes to red with white
background to make the text more readable.

• Reorganized Menu structures for easier navigation.
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System Description

The Imagenex Model 872 "YellowFin" is a full-featured dual channel, high-resolution, side-scan
sonar.  The YellowFin is an affordable, user friendly system that incorporates a high speed
Ethernet connection to your Windows™ based laptop or desktop PC.  Integrated power and an
optional differential-ready GPS receiver complete this fantastic system.  Zoom windows are
available for target investigation without interrupting real-time data acquisition.  Data is displayed
in real-time, with or without speed correction, in 9 user selectable color tables.

Getting Started:

After you are sure you have correctly wired the system, turn the power on to the surface board and

your computer. After the operating system started, double click the program icon  on your
desktop screen to launch the YellowFin program. You can exit this application by clicking the
close window button at the upper right corner of the screen or use the menu command
“File->Exit”.

YellowFin.exe is a Windows program that controls, displays and records data from the YellowFin
Sidescan Sonar System. The program uses a high speed Ethernet connection (10Mbps) to
communicate with the Model 872 sonar unit.

This document describes how to use the commands provided by the YellowFin program to control
the Model 872 sonar unit and how to view the data.

Screen Layout

The default screen layout of YellowFin.exe program provides a vertically displayed sonar image
with a user menu on top and a toolbar at left, as well as a status bar at the bottom in real time data
acquisition operation. If you run YellowFin.exe for file playback, there will be a Playback bar
shown under the user menu. You can resize the sonar image display window and hide the toolbar
or status bar by using the menu command: “View->Tool Bar” or “View->Status Bar” or
“View->Playback Bar”.

Operations:

When you start running the YellowFin.exe program, it first prompt you with a dialog box asking
if you want to run it in real time sonar data acquisition mode or run file playback. If you want to
run real time sonar data, please click the “YES” button. The program will try to connect to the
sonar head using the specified IP address. If you only want to playback a file, please click the
“NO” button, and the program will not connect to the sonar head. This also saves time in case
there is no Ethernet connection available.
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Interrogating the sonar unit:

Real-time sonar data interrogation needs communication between the YellowFin program and the
sonar unit. The communication protocol is based on high speed Ethernet. The YellowFin.exe
program uses another thread to send operation commands to the sonar head and then receive sonar
data returns.

You can save real-time data to a file by using the menu command “File->Record Data” or

clicking the Toolbar button  for post process or later inspection. Use the menu command

“File->Stop Recording” or clicking the Toolbar button  to quit saving data.

File playback:

You can also use the YellowFin program to playback data that has been recorded to a file (with
file extension ".872" or ".xtf" or ".ss2").

To open a .872, .xtf or .ss2 data file to playback, use the menu command “File->Open a file” or

click the Toolbar button . When the program is running with file playback, the frame window
will show a File Playback dialogue bar under the main menu. You can drag and dock it to a
convenient place on the screen. This dialogue bar lets you control the playback speed and
playback file position. See the section “File Playback Progress Dialog Bar” section for details.

Once you open a sonar data file to playback, the operation of real-time sonar data acquisition will
stop. You can open only one data file to play back at a time. But you can open another data file to
playback during file playback, the previously opened file will be closed.

You can once again change the operation to real time data interrogation by using the menu

command “File->Connect…”,  “Communication->Reconnect” or click the Toolbar button .
When the system starts to acquire data from sonar head, opened data file will be closed. If the
Ethernet connection is lost or failed, you can use the menu command
“Communication->Reconnect” to reconnect.

Note: There are several things that can cause lost or failed connection. One is that the
user turned the power of surface processor off. The other is that the Ethernet connection
is not configured correctly.

The YellowFin program provides several convenient ways (menu commands, dialog boxes, and
toolbar commands) to control the sonar unit’s operations, operating parameters and data display
windows.
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Sonar Image Manipulation

The YellowFin program uses a bitmap image with the size of the display screen to display the
sonar image. When the program receives one sonar shot data either from real-time or playback,
the data will be displayed at the top line of the image and the previous shots will be shifted down.

You can use the command “Zoom In” or command “Zoom Out”  to zoom in or out the image and
use the command “Hold” to pause the image display. When you zoom in, the image size will be
larger than the display window size. Thus, some portion of the image will be hidden beyond the
size of the display window. If you want to see the hidden part of the image, you can drag the
image to let that part fall in the display window. You can move the image by holding down the
left mouse button and dragging (moving) the image. When you release the left mouse button, the
image dragging operation will stop. Use the command “Restore Image” to restore the sonar image
to its original size and position.

Note: If the hold command is activated during file record, data is still recorded
although the display does not move. This allows the user to inspect an area of interest
without losing any data
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MAIN MENU

Figure 1 - YellowFin Menus

File menu commands

The File menu offers the following commands:

Connect to Sonar
Head…

Use this command to establish a Ethernet connection between the sonar
head and the control computer. If the connection is established
successfully, the YellowFin program will start to interrogate the sonar
head for data in real time. This command is very useful when you change
the operation from file playback to real time data acquisition. If this
command is disabled, which means the program is operating in real time
data acquisition mode not in file playback mode. If the connection has
failed, after a minute or so, the program will display a error message “No
Connection!”. You can check the wiring and reconnect the network again
by using the “Communications->Reconnect” command.

Shortcuts

Toolbar Button:
Keys: Ctrl+N

Playback… Use this command to open a previously recorded YellowFin sonar data
file (with the file extension .872 or .xtf or .ss2) to play back. The
YellowFin program displays the File Open dialog box so you can choose
which file you want to open.

Shortcuts

Toolbar Button: 
Keys: Ctrl+O

Record Data  or
Copy Start…

Use this command to save real-time sonar data to a file or copy part of a
file to another one during playback. YellowFin displays the Save As
dialog box so you can name your file. The file name can be any characters
and digits combined. YellowFin will automatically add file name
extension .872 or .xtf to your file name, depending on what file format
you choose, so you don’t have to type the file extension. Then YellowFin
will continue interrogating sonar unit for data and at the same time
recording those data to your named file.

You can use Stop Recording command to quit recording data. YellowFin
then closes the named file.
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During file playback, “Record Data” is replaced with “Copy Start”. This
allows you to copy data from one file to a separate file.

Shortcuts

Toolbar:
Keys: Ctrl+S
.

Stop Recording  or
Copy End

Use this command to stop the recording or copying sonar data to a file.
YellowFin will close the file. You can use the Open a File command to
open it for playback.

Shortcuts

Toolbar:
Keys: Ctrl+Z

Settings Change
Alarm

New

Use this command to play a sound when a setting changes during file
playback Supported settings are: Range, Mode, and End of File

Save Screen Use this command to save the whole sonar image (within the sonar image
display window) to a named image file. The image file formats can be
".bmp", ".jpg", ".png", ".tiff" and ".gif".

Save Selected Use this command to save part of the sonar image to a named image file.
The image file formats can be .bmp, jpg, .png, .tiff and .gif.

Note: Before you use this command, you should use toolbar “select”

command to select an image area. Put the display on hold, then push

the “select”  button and the program is in the select mode. Hold down
the left button of your mouse at the start point and drag the mouse to the
end point of your interested area and then release the button. The program
will draw the selected area with dashed lines. If you are not satisfied about
this selected area, you can selected again and your first selected area will
be discarded. After you selected an area, you can use this command to

save it to an image file. You should click the “select”  button again to
release this select mode so the program can respond to other commands
properly.

If there is no selected area available, this command will be disabled.
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Exit Use this command to terminate your YellowFin program. The system will
save your display layout, sonar settings, and GPS configuration to a text
file called YellowFin.cfg. Next time you start the program, the system will
load these settings from this file.

Mouse: Double-click the application's Control menu button.

Keys: ALT+F4

View menu commands

The View menu offers the following commands:

Clear Screen Use this command to clear the image in display window.

Shortcuts

Toolbar Button:
Keys: c

Grid Use this command to display and hide the vertical grid line.

Grid Text Size Use this command to change the text size used as range text marks
displayed at the bottom of the display window and measurement text
marks.

Hold Use this command to pause the image display. Toggle this command to
pause or continue the image display. Note that this holds the display only.
Data will still be recorded to the current file.

Shortcuts

Toolbar Button: 
Keys: h

Zoom In

Updated

Use this command to zoom in the image. Beginning in version 1.08, this
command centers the zoom area around the mouse position. The zoom
factors are 1x1, 2x2, 3x3, 4x4 and 5x5.

Shortcuts

Toolbar Button: 
Keys: z
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Zoom Out Use this command to zoom out the image.
Shortcuts

Toolbar Button: 
Keys: z

Restore Image Use this command to restore the sonar image to its original size and
position. When you move the image by click and drag the image, and then
zoom in/out the image, the image may not be seen in the viewing window.
Use this command to restore the image to its original size and position.

Shortcuts

Toolbar Button: 
Keys: r

Port Only Use this command to display only the Port channel. Note that, if recording
a file, both channels are always recorded regardless of the display view.

Stbd Only Use this command to display only the Starboard channel. Note that, if
recording a file, both channels are always recorded regardless of the
display view.

Both Sides Use this command to display both Port and Starboard channels.

Status bar Use this command to display and hide the status bar, which shows some
of the important information in YellowFin, such as operating range, data
gain, etc. A check mark appears next to the menu item when the Status bar
is displayed.

Toolbar Use this command to display and hide Toolbar, which includes buttons for
some of the most common commands in YellowFin, such as playback and
measurement commands, such as measure target height and measure
distance. A check mark appears next to the menu item when the Toolbar is
displayed.

File Playback bar Use this command to display and hide the File Playback Progress dialog
bar , which includes playback speed spin buttons and file playback
progress display. A check mark appears next to the menu item when the
File Playback bar is displayed.
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Show Time Marks Use this command to show a time text mark at the current mouse position
indicate the time for that sonar shot.

Shortcuts

Toolbar Button: 

Show GPS Marks

NEW

Use this command to show or hide GPS data at the current mouse
position. The Latitude, Longitude, Speed, and Heading of the cursor
position (not the current position) are displayed.

Show Range

NEW

Use this command to show or hide the range display in the upper left
corner of the image.

Show Mark Shadow Use this command to show or hide the black background for the text
marker display.

Units Use this command to choose which display units you like to use. Range
and distance can be displayed in meters (Metric) or feet (Imperial).

Vertical Blending Use this command to display a data-blended image using ship speed and a
blending technique. This is only applicable when ship speed is not zero.

Color Indicator Use this command to display and hide the color table indicator bar, which
displays the color table used to represent echo strength. If enabled, this
color table bar is displayed on the right side of the sonar image display
window. The upper level colors represent higher echo strength, and lower
level colors represent lower echo strength. A check mark appears next to
the menu item when color table indicator bar is displayed.

Use the menu command ColorTable to choose your preferred colors to
display the sonar image.
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Color Table Menu Commands

The Color Table menu is used to change the sonar data colour palettes for the sonar images.

YellowFin uses colours (called colour table) to represent echo data strength (amplitude). For
example: Normal High intensity color table used for mapping the echo data amplitude to 256
colors ranging from Black (low strength level) though blue, green, orange yellow white and red
(highest strength level).

The Color Table menu offers the following commands:

Normal High Standard colour table used for mapping the echo data amplitude to 256
colours ranging from Black (low level), through Blue, Green, Orange,
Yellow, White and Red (highest level).

Normal Low Same colours as Norm Hi, but uses a lower colour intensity.
Green 256 shades of green.
Grey 256 shades of gray (White on Black).
Reverse Grey 256 shades of gray (Black on White).
Brown/Yellow 256 mixed shades of brown and yellow.
Green/Blue 256 mixed shades of green and blue.
Green/Yellow 256 mixed shades of green and yellow.
Blue 256 shades of blue.

Settings Menu Commands

The Settings menu offers the following commands:

Sonar Settings Display the Sonar Settings Dialog Box. If the dialog box is
visible, this command will be disabled.

See Sonar Settings  Dialog Box and Diagnostics Dialog Box for details about sonar settings and
diagnostic items.

Communication Menu Commands

The Communication menu offers the following commands:

Reconnect Use this command to re-establish the connection between the PC
and the sonar head. This command is different from
“File->Connect to Sonar Head…” which used to change
operation from file playback to real time acquisition. The
“Reconnect” command is used to reconnect the Ethernet link in
real time acquisition mode.

Diagnostics Display the Diagnostics Dialog Box. If the dialog box is visible,
this command will be disabled.
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GPS Options menu commands

The Communication menu offers the following commands:

Show Speed/Heading Only Show or hide the ship speed and heading information at the
right bottom corner of the screen. A check mark appears next
to the menu item when only the speed and heading are
displayed.

Show All GPS Data Show or hide the all GPS data, include latitude/longitude,
speed/heading, and date/time at the right bottom corner of the
screen. A check mark appears next to the menu item when the
all GPS data is displayed.

Show GPS Data in a Dialog Use this command to display GPS data in a dialog box (GPS
Info Dialog) so you can move this dialog box to a convenient
place.

Show GPS Track Plotter Use this command to open another window, which displays
the sonar (or the ship) track plotted according to the GPS
provided latitude and longitude information.

GPS Comm Port Settings Configure the serial communication port for GPS data
acquisition. The baud rate, stop bits, parity, etc. should match
those of the GPS receiver.

Speed Correction Use this command to enable or disable Speed Correction.

The ship’s (or sensor) speed information is obtained from the
system GPS receiver. The YellowFin program will use the
ship’s speed and slant range information to rearrange sonar
image so the image will not distort in one dimension.

GPS Enabled Use this command to enable or disable the GPS data
acquisition. When it is enabled, the YellowFin program will
read those GPS sentences from a serial port and then decode
them according to the sentence type the user selected. In
version 1.04, GPS is always enabled. If there is no GPS
receiver, the program will display “n/a” in the GPS data
display fields.

GPS Text Size Use this command to change the text size used as GPS data
displayed at bottom right corner of the display window.

Convert UTC to Local Time
New

Use this command to adjust GPS time to match the current
local time.
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Synchronize with GPS Time
New

Use this command to adjust the computer’s local time to
match the GPS local time

Zoom in Use this command to zoom in the GPS tracking plot
according to the relative 10m, 20m, 50m, 100m, 200m, 500m,
1000m per division grid, that is 5.0, 2.5, 1.0, 0.5, 0.25, 0.1,
0.05 for zoom factors.

Shortcuts

Keys: +

Zoom out Use this command to zoom out the GPS tracking plot
according to the relative 10m, 20m, 50m, 100m, 200m, 500m,
1000m per division grid, that is 5.0, 2.5, 1.0, 0.5, 0.25, 0.1,
0.05 for zoom factors.

Shortcuts

Keys: -
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Measure Menu Commands

The Measure menu offers the following commands:

Draw ‘+’ Mark Draw a mark (+) on the Screen at the current mouse position.

Shortcuts

Toolbar Button: 

Measure Target
Height

Measure the target height.

Shortcuts

Toolbar Button: 

Measure Range Measure horizontal (slant) range between the sonar and the target or
current mouse position. Draw a horizontal line on the screen, with the
range shown.

Shortcuts

Toolbar Button: 

Measure Distance Measure the distance between two targets. Draw a line on screen, with
the distance shown.

Note: The ship (or sensor) speed is needed to measure vertical distance
(along the ship heading direction) correctly. It is not measured correctly if
it is in the screen area without any sonar image.

Shortcuts

Toolbar Button: 

Clear Lines/Marks Deletes all lines and symbols and text marks drawn on the screen.

Shortcuts

      Toolbar Button: 

See following for command details:

Draw ‘+’ Mark This command is used to draw a mark (+) on an echo by first
clicking the command and then clicking the echo that you want to
draw the mark on. Repeat the operation to draw more marks.
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Measure Target Height This command is used to measure the approximate height off the
bottom of a target (assuming a flat bottom). When selected, the
cursor will display ‘Click on the Target’. At this point, position the
target cursor on the target of interest and press the left mouse
button. A Horizontal rubber-banded line is drawn from the cursor
position to the beginning of the transmit pulse with the message
‘Click on First (Bottom) Return’. Position the cursor so that the
end of the rubber-banded line is at the beginning of the bottom
return (the end of the water column) and press the left mouse button
again. The message ‘Click on Shadow Start’ is now displayed.
Position the cursor at the beginning of the shadow that the target has
cast and press the left mouse button. The message
‘Click on Shadow End – H = ???M’ is displayed. Move the cursor
to the end of the shadow to display the height measurement. Press
the left mouse button again to begin a new measurement.

Measure Distance This command is used to measure the distance between two random
echoes by clicking on one echo and moving the cursor to the other
echo and click it on the display window. This command draws a
line connecting these two selected echoes, a start symbol (+) and a
stop symbol (+). The distance between these two echoes is shown as
“xxx.x m” or “xxx.x ft” at the end of the line.

Measure Range This command is used to measure the range from the center of the
sonar to a target. When you first click on the command, the
YellowFin program will draw a temporary horizontal line from the
center of the sonar to the current mouse position. Move the mouse
to a selected target and the temporary horizontal line moves with the
mouse. Click on the target,  the YellowFin.exe program will draw
that horizontal line permanently. The Range mark ”xxx.x m” or
“xxx.x ft” is shown at the end of the line.

Clear Lines/Marks This command is used to clear all the objects drawn on the screen.

Note: Since the sonar image is displayed as a moving picture, it is highly recommended
that you place the display on hold before doing any measurements and clear those lines
and marks before you release the hold status. If recording to a file, data will still be saved
while the display is on hold.

Help menu commands

The Help menu offers assistance with this application:

About YellowFin Use this command to display the copyright notice and version number of
your copy of YellowFin as well as contact information.

Toolbar Button: 
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Toolbars and File Playback Progress Dialog Bar

Main Toolbar

Figure 2 - Main Toolbar

The main toolbar is displayed at the left of the application window. The toolbar provides quick
mouse access to many tools used in YellowFin program.

To hide or display the Toolbar, choose Toolbar from the View menu.

Click To

Connect to sonar head.

Open an existing data file to play back.

Save real-time acquired sonar data to a file or copy playback data to another file.

Stop saving real time data or stop copying playback data.

Increase operating range by one level.

Range: 10m, 20m, 30m, 40m, 50m, 60m, 80m,  100m, 125m, 150m, and 200m for
low and medium frequency.

Range: 10m, 20m, 30m, 40m, and 50m for high frequency

Decrease operating range by one level.

Increase data (display) gain by 1% (0~100%).

Decrease data (display) gain by 1% (0~100%).

Clear the screen.

Toggle this command to pause or continue the image display.

Zoom in. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5

Zoom out. The zoom factors are 1x1, 2x2, 3x3, 4x4 and 5x5

Select an image rectangle area to save to an image file.

Draw a mark (+) on the screen at the current mouse position.

Measure target height.

Measure distance between two targets.
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Measure slant range from the center of the sonar to the target.

Deletes all lines and marks drawn on the screen.

Restore image to its original size (1x1) and position.

Toggle this command to show or hide time mark on screen.

Show the about dialog box displaying the copyright notice and version number of your
copy of YellowFin as well as contact information.

File Playback Progress Dialog Bar

Figure 3 - File Playback Progress Bar

File Progress A slider bar with a pointer showing file playback position. Dragging the
pointer to a new position will cause the file playback start at that position.
The slider range represents the file size. Note: You should always drag the
pointer to a proper file playback position and avoid clicking on the edge of
the slider bar, since that will cause the pointer stop moving as the file
playback goes along. In that case, the pointer position will not reflect the
file playback position correctly. You can drag the pointer once again to
make the pointer move correctly.

Play Back Speed Press the spin button up or down will change the playback speed faster or
slower. The speed change will show in the adjacent progress bar.
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Dialog Boxes

Connection Dialog Box

Figure 4 - Connection Dialog Box

This dialog box will appear when you start your YellowFin program. If you are ready for real-time
data acquisition, click the “YES” button. The program will connect to the sonar head via an
Ethernet link. If you only want to playback data files, please click “No” and the program will
conveniently display “File Open” dialog box for you to choose a data file to playback. Please do
not change the IP address as the sonar address is statically assigned from the factory. For more
information, please refer to the “YellowFin Ethernet Setup Guide” available from Imagenex
Technology Corp.
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File Open Dialog Box

The following options allow you to specify which file to open:

File Name Type or select the filename you want to open. This box lists files with the
extension you select in the List Files of Type box.

List Files of Type Select the type of file you want to open: The supported file extensions are
“.872” or “.xtf” or “.ss2” if opening a sonar data file. The file with file
extension “.872” is the standard YellowFin recorded file format.
YellowFin.exe can playback files with file extension “.xtf” (Triton
Extended File Format) ONLY if the “.xtf” file is recorded by the YellowFin
program. The file extension “.ss2” is the old YellowFin file format.
YellowFin.exe can playback “.ss2” files but it is not recommended to
record data to this file format in the future.

Drives Select the drive in which YellowFin control software stores the file that you
want to open.

Directories Select the directory in which YellowFin control software stores the file that
you want to open.

Network... Choose this button to connect to a network location, assigning it a new
drive letter.

File Save As Dialog Box

The following options allow you to specify the name and location of the file you're about to save
sonar data into:

File Name Type a new filename or select an existing file name to save sonar data into
that named file.

Drives Select the drive in which you want to store the document.

Directories Select the directory in which you want to store the document.



Imagenex Technology Corp. ©2004 Model 872 ver 1.09 User’s Manual

Page 18 of 24

Sonar Settings Dialog Box

Figure 5 - Sonar Settings  Dialog Box

The following options allow you to select sonar settings. These parameters are mainly used to
operate the YellowFin sonar.

Range  Select the acoustic operating range.
Options:

• Low or Medium Frequency: 10m, 20m, 30m, 40m, 50m, 60m,
80m, 100m, 150m, and 200m.

• High Frequency: 10m, 20m, 30m, 40m, 50m

Data Gain (Display Gain) Choose a Data Gain you want (from 0 to 100%). Data Gain
is used to increase or decrease the intensity (color levels) of the sonar
image.

Mode/Freq There are three frequencies to choose from: low, medium and high.

Gain Balance The gain balance code is from 0 to 60 match the gain:
Port gain : [30- (gain balance code)]/10 dB
Stbd gain : [(gain balance code) – 30]/10 dB
The port gain add starboard gain will be zero dB.

Drag the gain balance slider bar to change the gain balance. The Port and
Stbd edit boxes are only used for display purposes.
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Diagnostics Dialog Box

Figure 6 - Diagnostics Dialog Box

The Diagnostics Dialog Box is used to display important system variables. This dialog box is very
useful when trouble shooting the system in real-time. In file playback, certain system variables
such as Header, Serial Stat, and Run-Type etc. are not available to display since they are not
recorded into the data file.

Header Sent by the sonar system (wet end) to tell the processor what kind of data
format it sent, IGX for YellowFin sonar image.

Serial Stat Indicates if the communication between sonar system and processor is
normal (0x40 or 0x42) or not (other than 0x40 or 0x42).

Run-Type Sent by the sonar system (wet end) to tell the YellowFin program what
command the sonar is responding.

0: standard sonar shot
1: set Mode/Freq
2: set Range
3: set Gain Balance

Mode/Freq  0: Low frequency
1: Medium frequency
2: High frequency
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Range Index Current YellowFin sonar operating range index.

5:   10m
6:   20m
7:   30m
8:   40m
9:   50m
10: 60m
11: 80m
12: 100m
13: 125m
14: 150m
15: 200m

Range Current YellowFin sonar operating range.

Data Gain Current YellowFin sonar operating Data Gain.

Gain Balance Current YellowFin sonar operating Gain Balance.

Link Command Sent by the YellowFin program to sonar head indicating the operating
parameters are changed by the user.

0: standard sonar shot
1: set Mode/Freq
2: set Range
3: set Gain Balance

PRF Milliseconds elapsed between the two consecutive interrogations for the
sonar head.
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GPS Info Dialog Box

Figure 7 - GPS Info Dialog Box

The GPS Info Dialog Box is used to display GPS information. The YellowFin system can get
latitude/longitude, speed/heading and date/time (GMT) from the integrated GPS receiver. The
YellowFin system can decode 4 types of sentences (RMC, GGA, GLL, and VTG) compatible with
NMEA 0183 specifications. Latitude/Longitude display uses dd.mm.mmmmN (or S) and
ddd.mm.mmmmW(or E) formats. Speed is displayed in knots and heading (course over ground) is
displayed in 000.0 to 359.9 degrees. Time is Greenwich Mean Time.

GPS Serial Port Configuration Dialog Box

Figure 8 - GPS Serial Port configuration Dialog Box
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The GPS Serial Port Configuration Dialog Box is used to configure the GPS serial
communications on your PC.

Com Port Specifies the communication serial port to be used.

Baud Rate Specifies the baud rate at which the GPS communications operates. The
default is set to use 4800 bits/second baud rate.

Data Bits Specifies the number of bits in the bytes transmitted and received. The
default is set to use 8 bits byte size.

Parity Specifies the parity scheme to be used. The default is set to use No Parity
scheme.

Stop Bits Specifies the number of stop bits to be used. The default is set to use one
stop bit.

Flow Control Not used

Format Specifies GPS sentence types to be used. The default is set to RMC.

The Baud Rate, Data Bits, Parity and Stop Bits should match those in the GPS receiver
specifications.
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Appendix A – Target Height Calculation
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Target Height Calculation

Figure 9 - Target Height Calculation
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Appendix B – Post Processing Resources

The YellowFin Sonar System Provides several aids for post processing sonar data. When
recording a file, one may choose to record the data in a “.xtf” or “.872” format. YellowFin.exe is
able to playback a “.xtf” file that was recorded using YellowFin.exe. Also, Data from a “.872” or
a “.xtf” file may be “copied” to a .xtf file using the Copy Start and Copy Stop commands in the
File Menu.

Once the “.xtf” file is generated, post processing may be done on this file. Two common post
processing programs are:

• SonarWeb
• SonarWiz.MAP

by Chesapeake Technology, Inc. (http://www.chesapeaketech.com)

http://www.chesapeaketech.com/
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Introduction
The Imagenex Model 872 YellowFin side scan sonar system consists of an underwater sonar head
connected via analogue telemetry directly to a surface interface processor. This processor contains
the necessary power to run the underwater unit, a built-in differential capable GPS unit, and an
Ethernet enabled interface board.

This document covers the necessary setup procedures to enable your Windows© XP© based PC to
communicate with the processor.

Ethernet Cable
The included Ethernet cable specifications are:

• Cat 5e
• RJ-45
• 568B wiring scheme

If this cable needs to be replaced, ensure that  the above specifications are met.
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Configuration of Windows XP Ethernet Communications

For the YellowFin System, the following Address’s are used

PC
IP Address 192.168.0.X
Subnet Mask 255.255.255.0

Where ‘X’ is a decimal number between 3 and 255. The number ‘1’ is reserved for a network
server, and ‘2’ is reserved for the YellowFin processor.

The YellowFin processor has a statically assigned IP Address of 192.168.0.2 . This is the
number to enter in the Connection Dialog Box as shown in Figure 3

The Recommended PC’s IP address and Subnet Mask on the PC are:

IP Address 192.168.0.3
Subnet Mask 255.255.255.0

On a Windows© XP© based machine, this is done as follows:

1. Navigate the Control Panel and double click “Network Connections”
2. Right click on the Ethernet interface you wish to connect with and select “Properties”

Figure 1 - Local Area Connection Properties Dialog Box
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3. Select Internet Protocol (TCP/IP) and select “Properties”

Figure 2 - TCP/IP Priorities Dialog Box

4. Enter the information shown above in Figure 2 and click “OK” to accept the changes.
5. Click “OK” again to accept the changes.

Now your computer is on the same “Network” as the Processor. When starting the YellowFin.exe
program, a dialog box as shown below in Figure 3 will appear asking for the IP Address. Enter
the Processor’s IP Address, NOT the PC’s address. (Note: The current IP Address is saved in
the “YellowFin.cfg” file located in the programs root folder)

Figure 3 - YellowFin.exe Connection Dialog Box

The processor has a statically assigned IP Address of 192.168.0.2 . Enter this number in the Connection Dialog Box.



Imagenex Technology Corp. Ethernet Setup Guide for Model 872 YellowFin

Updated on November 10, 2004 Page 5 of 8
C:\Documents and Settings\Craig\My Documents\Projects\Ethernet Setup Guide.doc

The system will run fine. However, if communication to the head does not function properly, try
these suggestions.

1. Disable any network bridges that are present
• A network bridge allows a separate port, such as “USB”, or “Firewire” to piggyback

the Ethernet connection.
• Under “Network Connections”, if there is a network bridge icon, disable it.

Under “Network Connections”, right-click on the Ethernet card and select properties.

2. Clear unnecessary network protocols
• De-select all services except for “Internet Protocol (TCP/IP)”

3. Remove any firewalls present (Note that Windows© XP© has a rudimentary firewall
built into it. Disable this one first).

• Select the “Advanced” Tab. De-select the Firewall option (if present).

Click on “Configure” (in the “General” tab) and a new dialog box will appear.

4. Set Link speed to “Auto” or “10Mbps”
• In the “Advanced” tab, select  “Link Speed / Duplex Mode” and set to either “Auto Mode” or “10 Full

Mode”.

5. Disable any power saving that shuts down the Ethernet card.
• In the “Power Management” tab, de-select any power saving option.

Sharing an Ethernet Device with the Sonar and Internet

If the computer will be using the same Ethernet card for both the sonar and Internet uses (NOT
at the same time), set the card for the sonar using the above procedures. When using the Internet,
you will need to reset the IP, Subnet, Default Gateway, and DNS Server to correspond to your
Internet Service Provider. On most modern systems, this may as simple as setting the system to
“Obtain settings Automatically” This will set the computer to use the DHCP protocol.

The YellowFin processor has a statically assigned IP Address of 192.168.0.2 . To re-use the
Sonar system, the above procedures MUST be followed
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Appendix A – Setting up a Direct Connection
This is the simplest way to connect to an Imagenex Ethernet Sonar System (IESS) to a computer
(PC) as shown in Figure 4. In this configuration, there is simply a direct connection between the
IESS and the operating PC. Note that the PC has a static IP address of “192.168.0.157”.

Cat 5e

IP = 192.168.0.157

Sonar Device

IP = 192.168.0.2

Figure 4 - Connecting the IESS via Direct Connection
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Appendix B – Setting up a LAN
To connect an Imagenex Ethernet Sonar System (IESS) to a Local Area Network (LAN), refer to
Figure 5. The advantage of this setup is that the IESS may be operated from any computer that is
connected to the LAN. Note that the server computer must be running Windows© XP© PRO in
order to set up a LAN. This is because only XP© PRO contains the necessary DHCP server
component to auto-configure the client PC’s. The server also has a static IP address of
“192.168.0.1” and no other PC on the network may have this IP. Currently, the IESS does not
support DHCP and is simply “piggy-backing” the network by using an IP that is on the same
Subnet Mask as the LAN.

HUB

Sonar Device

IP = 192.168.0.2

IP = 192.168.0.1

IP = 192.168.0.144 IP = 192.168.0.157

Server

Cat 5e

Cat 5e
Cat 5e

Cat 5e

Figure 5 - Connecting the IESS via a LAN
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Appendix C – Setting up a Networked LAN
To connect an Imagenex Ethernet Sonar System (IESS) to a networked Local Area Network
(LAN), refer to Figure 6. This setup consists of two LAN’s interconnected via a router. The
router acts as a server to the LAN that is directly connected to the IESS. The advantage of this
setup is that the IESS may be operated from any computer that is connected to either LAN. The
server has a static IP address of (for example) “172.16.0.1”. The router essentially has to sides.
One side is configured as a client (“172.16.0.127”) and the other side is configured as a server
(“192.168.0.1”). Currently, the IESS does not support DHCP and is simply “piggy-backing” the
network by using an IP that is on the same Subnet Mask as the LAN.

HUB

Sonar Device

IP = 192.168.0.2

IP = 172.16.0.1

IP = 172.16.0.13 IP = 172.16.0.45

Server

172.16.0.127

192.168.0.54
Router

IP = 192.168.0.157

Cat 5e
Cat 5e

Cat 5e

Cat 5e

Cat 5e Cat 5e

Figure 6 - Connecting the IESS through a multiple LAN
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When recording the YellowFin data to a .872 file, the following bytes are appended and
saved to the file every ping. The total number of bytes ‘N’ for each ping is equal to 4096.

Byte # Byte Description
0-999 File Header (1000 bytes)

1000-1999 Port Channel Echo Data (1000 bytes)
2000-2999 Starboard Channel Echo Data (1000 bytes)
3000-3nnn GPS Strings (100 bytes/string)
3nnn-4093 Zero Fill

4094-4095

Pointer To Previous Ping
The last 2 bytes of this ping contain a 16-Bit number that is the sum
of the number of bytes for this ping and the number of bytes for the
previous ping. This number can be used for reverse playback
synchronization.
Number of bytes to previous ping = ((Byte 4094)<<8) | (Byte 4095)

FILE HEADER

Bytes 0 through 999 contain the following File Header information:

0 ASCII '8'
1 ASCII '7'
2 ASCII '2'

3 872 File Version
0 = v1.xx – 1000 points/channel, 8-Bit data

4-7 Ping Number – increment for every ping

Byte 4 Byte 5 Byte 6 Byte 7
7 - 0 7 – 0 7 - 0 7 - 0

Ping Number

8-9 Total Bytes ‘N’ - number of bytes that are written to the disk for this ping

Byte 8 Byte 9
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

N = 4096
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YELLOWFIN DATA STORAGE FILE FORMAT (.872) (con't)

10-11 Data Points Per Channel

Byte 10 Byte 11
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

1000

12 Bytes Per Data Point
always 1

13 Data Point Bit Depth
always 8

14 GPS Type/ Number of GPS Strings
GPS Type indicates which NMEA 0183 message was selected by the user
and used for decoding Lat/Lng coordinates. Number of GPS Strings
indicates how many GPS strings were detected and stored. Each string is
stored (in ASCII) exactly as it appeared at the serial communications port
during real time data acquisition. The strings are stored in a 100 byte slots
starting at GPS String File Offset (Bytes 15-16).

Byte 14
7 6 5 4 3 2 1 0

GPS Type Number of GPS Strings

GPS Type:
0  $GPGLL
1  $GPGGA
2  $GPRMC

NMEA 0183 GPS Strings stored at the following offsets:
$GPGLL: stored at GPS String File Offset + 0
$GPGGA: stored at GPS String File Offset + 100
$GPRMC: stored at GPS String File Offset + 200
$GPVTG: stored at GPS String File Offset + 300

15-16 GPS String File Offset

Byte 15 Byte 16
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Offset = 3000
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YELLOWFIN DATA STORAGE FILE FORMAT (.872) (con't)

17-18 Event/Annotation Counter

Byte 17 Byte 18
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0
E Count:   0 to 32767

E = 0, no event, ignore count
E = 1, new event, increment count and append annotation file
Annotations are stored in “filename.an”
Each annotation contains a maximum of 512 characters.

19-30 Date – system date, null terminated string (12 bytes)
"DD-MMM-YYYY"

31-39 Time – system time, null terminated string (9 bytes)
"HH:MM:SS"

40-44 Thousandths of Seconds – system time, null terminated string (5 bytes)
".ttt"

45 Operating Frequency
0 = Low Frequency
1 = Medium Frequency
2 = High Frequency

46 Range Index – index numbers for acoustic operating range
5 - 10m
6 - 20m
7 - 30m
8 - 40m
9 - 50m
10 - 60m
11 - 80m
12 - 100m
13 - 125m
14 - 150m
15 - 200m

47 Data Gain
0 to 100 percent



Imagenex Technology Corp. ©2004 Yellowfin Data Storage File Format (.872)

Page 4 of 4

YELLOWFIN DATA STORAGE FILE FORMAT (.872) (con't)

48 Channel Balance
0 to 60  +/-3dB in 0.1dB increments
0 = +3dB Port / -3dB Stbd
30 = 0dB for both channels
60 = -3dB Port / +3dB Stbd

49-50 Repetition Rate – Time between pings

Byte 49 Byte 50
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Repetition Rate (ms)

51-52 Sound Velocity

Byte 51 Byte 52
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Sound Velocity (in meters/second) * 10

53-64 12 Byte File Header. Refer to the section “Interface Return Data” in the
document “YellowFin Ethernet Specification” for further details.

65-999 Reserved - always 0

1000-1999 Port Channel Echo Data
1000 data points (1 byte/point)
first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 – 255

2000-2999 Starboard Channel Echo Data
1000 data points (1 byte/point)
first range point = 1 * Range / 1000 in meters
last range point = 1000 * Range / 1000 in meters
intensity: 0 – 255

3000-3nnn GPS Strings – (100 bytes/string)

3nnn-4093 Zero Fill

4094-4095 Pointer to Previous Ping

Byte 4094 Byte 4095
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Number of bytes to previous ping = 8192
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OVERVIEW

The Interface Board (160-017.V3) communicates via an Ethernet connection to
Windows based PC. The PC software needs to know the IP address and the correct port
number of the sonar in order to create a socket. If a direct Ethernet connection is used,
then the PC’s Ethernet card must have a statically assigned IP and Subnet Mask matching
that of the sonar. If running through a local area net work, then the PC’s Ethernet card
may have dynamically allocated IP but the sonar’s IP address MUST be reassigned to
that matching the LAN.

To interrogate the underwater unit and receive echo data, a “Switch Data Command”
string is sent to the interface board, which, in turn, translates the data and sends “Sonar
Control Commands” to the underwater unit. When the Sonar Control Command is
accepted, the sonar transmits, receives and sends its return data back up to the interface
board. The interface board then packages the received data and sends it back to the PC
which, in turn, processes and plots the data.

To receive one sonar shot of acoustic data:

1. Send a TCP packet containing the Switch Data Command (with byte
18: Packet = 0x00).

2. Receive a TCP packet containing the Port channel’s data.

3. Send a TCP packet containing the Switch Data Command (with byte
18: Packet = 0x02).

4. Receive a TCP packet containing the Starboard channel’s data.

The Interface Return Data is the same for Port and Starboard returns. However, the
packet number and actual data reflect the different channels.
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SWITCH DATA COMMAND (PC to Interface Board)

The interface board accepts up to 27 bytes of switch data from the PC and must see the
“Switch Data Header” (2 bytes: 0xFE and 0x44 hexadecimal) in order to process the
switches. The interface board will stop accepting switch data when it sees the termination
byte (0xFD HEX). The termination byte must be present for the interface board to process
the switches.

Note: the Termination Byte is the only switch value allowed to
have a value of 0xFD. All other switches should be set higher or
lower than 0xFD (253 Decimal) so they are not interpreted as a
termination byte!

Table 1 - Switch Data Command To 160-017.v1 Interface board

Byte # Description
0 – 7 0xFE 0x44 Reserved Range Reserved Reserved Master/

Slave
Mode/Freq

8 – 15 Data Gain Sync Gain Balance
Gain

Reserved Reserved Link
Command

Reserved Reserved

16 – 23 Reserved Reserved TCP
Packet

Reserved Reserved Reserved Reserved Reserved

24 – 26 Reserved Reserved Term.
0xFD

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix.

Byte 0 Switch Data Header (1st Byte)
Always 0xFE (254 decimal)

Byte 1 Switch Data Header (2nd Byte)
Always 0x44 (68 decimal)

Byte 2 Reserved
0

Byte 3 Range
0x05 – 0x0F
Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m

Byte 4 Reserved
0

Byte 5 Reserved
0
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Byte 6 Master/Slave
Not used (0x43)

Byte 7 Mode / Frequency
0. Low Frequency
1. Medium Frequency
2. High Frequency

Byte 8 Data Gain
0 – 100%

Byte 9 Sync Gain
Automatically adjusted

Byte 10 Balance Gain
Integer values 0 through 60 decimal generates a matched gain balance in .1db
increments.

Starboard gain (dB) = 
10

30−x

Port gain (dB) = 
10

30 x−

Example x = 42

Starboard gain (dB) = dB2.1
10

3042 =−

Port gain (dB) = dB2.1
10

4230 −=−

Byte 11 Reserved
0

Byte 12 Reserved
0

Byte 13 Link Command (3 bits)
Down Telemetry value to YellowFin head

000 Standard Sonar Shot
001 Set Mode / Freq
010 Set Range
011 Set Gain Bal
100 Reserved
101 Reserved
110 Reserved
111 Link to Link
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Byte 14 Reserved
0

Byte 15 Reserved
0

Byte 16 Reserved
0

Byte 17 Reserved
0

Byte 18 TCP Packet Number (3 bits)
Indicates which TCP formatted packet is requested from the PC. The Sonar
shot is initiated on receipt of TCP Packet number = 0x00. Data is collected for
both Port and Starboard channels. Port data is then sent to the PC. On receipt
of 0x02, Starboard Data (which is already collected) is sent to the PC.

0x00 - Initiate Sonar Shot and return first TCP packet (Port data)
0x01 - Reserved
0x02 - Return second TCP packet (Starboard data)
0x03 - Reserved
0x04 -> 0x07 - Reserved

Byte 19 Reserved
0

Byte 20 Reserved
0

Byte 21 Reserved
0

Byte 22 Reserved
0

Byte 23 Reserved
0

Byte 24 Reserved
0

Byte 25 Reserved
0

Byte 26 Termination Byte
The Interface board will stop looking for Switch Data when it sees this byte.
Always 0xFD (253 decimal)
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INTERFACE RETURN DATA

After every shot, the interface board returns a 12 byte header, 1000 points of echo data, and a
terminating byte value of 0xFC. The total number of bytes (N), including the 12 byte
header, returned will be 1013.

Table 2 – YellowFin Return Data From 160-017.v3 Interface board to PC

Byte # Description
0 to 7 ASCII

'I'
ASCII

'G'
ASCII

'X'
Serial
Status

Sync byte
(LO)

Sync
byte

Sync
byte

Sync byte
(HI)

8 to 11 Sync Val
(LO)

Sync
Val
(HI)

Data
Bytes
(HI)

Data
Bytes
(LO)

12 to
(N-2)

Echo Data
1000 Data Bytes

N-1 Term.
0xFC

BYTE DESCRIPTIONS

Note: All Byte values are shown in decimal unless noted with a '0x' (hexadecimal) prefix.
N = total number of return bytes

Byte 0 - 2 Imagenex Return Data Header
ASCII 'IGX'
'I' = 0x49, 'G' = 0x47, 'X' = 0x58

ASCII 'IGX'
N = 1013, (1000 Data Bytes, 12 header bytes, 1 termination byte)

Byte 3 Serial Status

Bit 7 Bit 6 Bit 5 Bit 4 Bit 3 Bit 2 Bit 1 Bit 0
1 =

Character
Overrun

1 =
Switches
Accepted

0 0 0 0 Channel

0 0 Port
0 1 Reserved
1 0 Starboard
1 1 Reserved
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Byte 4-7 Sync message bytes

Byte 4 Byte 5 Byte 6 Byte 7
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0
0 0 Sync Message

(LO)
0 0 Sync Message 0 0 Sync Message 0 0 Sync Messages

(HI)

YellowFin Sync messages: 23 bits
YellowFin Sync messages:
(byte [4] & 0x3F) | (byte [5]<<6 & 0x0FFF) | (byte [6]<<12 & 0x3FFFF) |
(byte [7]<<18&0x7FFFFF)

Sync Messages:

Sync Word:
22 21 20 19 18 17 16 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0
1 1 0 0 Reserved (0’s) Information Run Type 1

Bits 22-21: Trigger (11)

Bits 20-19: Head ID (00)

Bit 0: Stop bit (1)

Bits 4-1: Run Type (Echo’s Link Control Bits)

(0000) Sonar data
(0001) Mode / Freq
(0010) Range
(0011) Gain Balance
(0100) Reserved
(0101) Reserved
(0110) Reserved
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Bits 12-5: Information

If Run Type = 0 or Run Type = 2
Range Index:

0x05 through 0x0F
Operating range: 10, 20, 30, 40, 50, 60, 80, 100, 125, 150, 200m

If Run Type = 1
Mode / Frequency:

0x00 through 0x02
 0. Low Frequency
 1. Medium Frequency
 2. High Frequency

If Run Type = 3
Gain Balance:

Integers 0 through 60

Bits 18-13: Reserved

Byte 8,9 Sync Value

Byte 8 Byte 9
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0
0 Sync Value (LO) 0 Rx Sync Value (HI) L

Sync value is used for diagnostics (normal sync value is around 800).
Sync Value Byte (LO), Sync Value Byte (HI)

Sync Value Byte (LO)= (Byte 9 & 0x01)<<7 | (Byte 8 & 0x7F)
 Sync Value Byte (HI)= (Byte 9 & 0x3E)>>1;
 Sync Value = (Sync Value Byte (HI)<<8) | Sync Value Byte (LO)

No_RX_Data = Byte 9&0x40
If No_RX_Data = 1, low or no sync value
If No_RX_Data = 0, normal sync value
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Byte 10,11 Number of data bytes

Number of Echo Data Bytes returned
Data Bytes (LO), Data Bytes (HI)

Byte 10 Byte 11
7 6 5 4 3 2 1 0 7 6 5 4 3 2 1 0

Data Bytes (HI) Data Bytes (LO)

Data Bytes = (Data Bytes High Byte<<8) | Data Bytes Low Byte

Byte 12 Start of Echo Data
(N-12) Bytes of data

1st Range Point = Byte 12
2nd Range Point = Byte 13
3rd Range Point = Byte 14
4th Range Point = Byte 15
etc. ...

Byte (N-2) End of Echo Data

Byte (N-1) Termination Byte
0xFC
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